Ducky078 Oct 2, 2014 4:40 AM 
Today my husband shutdown and restarted his Mac Pro as it was running slow and he hadn't turned it off for a few days. When he reopened Microsoft Outlook the entire email account was gone. He tried going back into Time Capsule to last night but nothing would work and then all the other Office programs disappeared. Apple support could only help so much, then they said to ring Microsoft. No help there, they put us onto Log Me In Rescue support and we have paid for them to try and fix it but they are having no luck at all.
 
They said our system has been hacked which we didn't think could happen on a Mac. We only had POP emails set up not exchange. Can anyone offer any support at all.
 
Cheers in advance
I have this question too Show 13 Likes (13) 
· [bookmark: 26750759][image: clintonfrombirmingham][image: Level 7]Level 7 (29,995 points) 
clintonfrombirmingham Oct 2, 2014 5:26 AM 
Re: Outlook email account disappeared after restarting in response to Ducky078 
Since you've been in contact with MS support, I doubt that any of my suggestions will be of any help... but...
 
Have you looked in your user>Documents>Microsoft User Data>Office 2011 Identities folder to make certain that there is a Main Identity there?
Have you tried rebuilding the Main Identity (by holding down the option key whilst starting Outlook)?
Have you tried deleting the "com.microsoft.Outlook.plist from the user Library>Preferences?
 
You may have already tried on these things (you're husband isn't running a version of the beta Yosemite, is he?) so they may not solve your problem.
 
Clinton
 
MacBook Pro (15-inch Late 2011), OS X 10.??, 16GB Crucial RAM, Crucial M500 960GB SSD, 27” Apple Thunderbolt Display
This helped me 0 members found this helpful (0) 
· [bookmark: 26751081][image: Ducky078][image: Level 1]Level 1 (0 points) 
Ducky078 Oct 2, 2014 6:15 AM 
Re: Outlook email account disappeared after restarting in response to clintonfrombirmingham 
Hi Clinton,
 
Thank you for giving me some suggestions. I will certainly check with him on these options and also see if he is running the beta Yosemite. At this stage any suggestion we will look at. Even Log Me In are having issues fixing it.
 
Thank you again.
This helped me 0 members found this helpful (0) 
· [bookmark: 26757495][image: Ducky078][image: Level 1]Level 1 (0 points) 
Ducky078 Oct 3, 2014 2:11 AM 
Re: Outlook email account disappeared after restarting in response to clintonfrombirmingham 
Hi Clinton,
 
Could you possibly offer any suggestions further to your last responses. The Log In Me Rescue online people are saying that the time machine backups are useless. They have managed to secure all ports and I think they are currently reinstalling MS office by remote log in but his entire email back up is gone. They said the time machine back up is useless. Any suggestions on how to access it at all if we have reinstalled outlook from fresh.?
This helped me 0 members found this helpful (0) 
· [bookmark: 26757700][image: clintonfrombirmingham][image: Level 7]Level 7 (29,995 points) 
clintonfrombirmingham Oct 3, 2014 2:30 AM 
Re: Outlook email account disappeared after restarting in response to Ducky078 
Ducky078
 
Microsoft (for some reason) scatters support files all over your drive - no wonder Microsoft is saying that a Time Machine restore (of only Outlook/Office) wouldn't help.
 
Did you try any of the things that I suggested? Those are the only ways that I know how to solve Outlook mailbox problems. Let me ask - when you open Outlook, do you see a full (but blank) Main Window?
 
Call back,
 
Clinton
 
MacBook Pro (15” Late 2011), OS X 10.??, 16GB Crucial RAM, 960GB M500 Crucial SSD, 27” Apple Thunderbolt Display
This helped me 0 members found this helpful (0) 
· [bookmark: 26758044][image: Ducky078][image: Level 1]Level 1 (0 points) 
Ducky078 Oct 3, 2014 4:10 AM 
Re: Outlook email account disappeared after restarting in response to clintonfrombirmingham 
I went back to him and this morning we had checked in the identities folder as you suggested and there was nothing in there. Checking again tonight there are files in there, but what we do with them we don't know. It could be from when to remote help people were reinstalling tonight.
 
What we have just discovered, and this was not there this morning, he went into Finder and All my files. It breaks things into different sections. There was a section saying Mail and messages and there are over 13,000 items in there and all his contacts are now there. We are not sure how they got there or how to get it back to Outlook. He went to do the rebuild but there are two identity options, and we are worried about making a mistake. Not sure what is going on. 
 
I have spent so much time in these forums and others trying to help and I am a person that is shocking with computers. I thank you for your help so far. Still playing with it and I booked him a session at the apple store tomorrow as well.
 
I just have to say how appreciative I am of the time you have given in trying to suggest solutions to our problem. There are so many people that just won't help. 
 
Cheers,
This helped me 0 members found this helpful (0) 
· [bookmark: 27426534][image: Rob Ryan][image: Level 2]Level 2 (485 points) 
Rob Ryan Jan 6, 2015 12:54 PM 
Re: Outlook email account disappeared after restarting in response to Ducky078 
For what it's worth, I'm seeing similar behavior. My wife's Mac Pro, running Yosemite 10.10.1, froze last night (it's the first time that's happened). She shut down the machine and restarted, and now her archive of emails is gone, and when you go to Outlook "Settings" - "Accounts", there's nothing listed there. I tried ClintonFromBirmingham's suggestions to no avail. Not that I expected to find anything, I did virus scan and nothing came up.
This helped me 0 members found this helpful (0) 
· [bookmark: 27631956][image: ChristopherDC][image: Level 1]Level 1 (0 points) 
ChristopherDC Feb 8, 2015 8:05 AM 
Re: Outlook email account disappeared after restarting in response to Ducky078 
This problem is occurring for me as well, though nothing is actually lost because I am connecting to the Exchange (OWA) server at work.  When restarting Outlook with the option key, the Microsoft Database Utility kicks in and says "cannot build new identity" and the REBUILD button does nothing at all.  
 
Ideas?  I can always just add my account info and restart my sessions, but it's frustrating!  Oh, Microsoft.
This helped me 0 members found this helpful (0) 
· [bookmark: 28060113][image: mohdib][image: Level 1]Level 1 (0 points) 
mohdib Apr 13, 2015 3:37 AM 
Re: Outlook email account disappeared after restarting in response to Ducky078 
This likely has to do with permissions set for the logged in user on the Documents folder and its sub-folders, particularly the folder named "Microsoft User Data" as Microsoft stores the Office identities there. Make sure you have write permission on the Documents folder in your own home directory. This should be the case by default. However, if folders are copied or moved around from another user, the ownership and permissions on the affected folder may no longer be correct and would have to be reset.
 
In case the ownership is not set correctly, running the following command from the terminal should set you as the owner on the Documents folder and its sub-folders
 
sudo chown -R yourusername ~/Documents
 
Enter your password when prompted.
 
Also, make sure that the Documents folder and its sub-folder have read, write, and excute for the owner.


  
Mirandashawyer 
macrumors newbie 
Aug 24, 2011
#1 
Hi I hope you can help

I have a 2011 MacBook Pro with Outlook.

The mac run out of battery.

When re-charged and re-started all outlook folders and email have gone.

I can't go back on the time machine as its in Australia and I am now in the UK for the next month.

And the servers that I have the email on aren't organized into folders its just 200,000 random historical emails as well as a older historical email from an old work email that I no longer have access to their serve to reinstall. 

If you have any ideas please let me - I'd be very grateful.

All the best

Miranda 
 
  Sep 23, 2011 
veehb 
macrumors newbie 
Oct 5, 2009
Taylorsville, Utah
#2 
I'm surprised that after more than a month, no one has responded to this!

I have a new 15" MacBook Pro running Lion 10.7.1. I'm also running Outlook 2011. It has been working pretty well for me. But, tonight I updated my Lion software (3 new updates were loaded). When it rebooted all of my Outlook files, folders, mail, distribution lists, contact lists, etc. were gone! 

So looks like there is a serious bug in Outlook 2011. Surely others have had this problem. It is really serious. I don't know how to restore the files using Time Machine. I have current backups of my system on Time Machine. 

I'm afraid that my only hope is to get them from Time Machine. I recently imported all my files from my Windows 7 PC (several years of email files, folders, distribution lists, etc.) and the import was successful. I didn't like the way it imported the distribution lists, but they were there.

Now, I've lost it all. It doesn't even have my msn.com account information. 

Can someone tell me how to recover these files. Please, someone respond to my request as well as the one I'm replying to! 
 
  Sep 25, 2011 
dianeoforegon 
macrumors 6502 
[image: dianeoforegon]
Apr 26, 2011
Oregon
#3 
When you have a hard crash, the system might put files into a hidden folder called "lost+found".
· Under the 'go' menu, select 'go to folder'. In that dialog, enter "/lost+found" (without the quotes).
· If there is a lost+found folder it will open, if not, you will get a 'folder not found' error.

We don't normally see reports of lost data after a battery lost power so not sure what is happening on your system.

Normally, when data goes missing it's user error. Most likely you have accidentally moved your data. Hopefully, you have not deleted the file. If you have deleted the trash, it's gone. Sorry!
Outlook stores your data in this location:

~/Documents/Microsoft User Data/Office 2011 Identities/your identity 

If you move the Main Identity, Office 2011 Identities folder or Microsoft User Data folder to a different location, Outlook will create a new blank Identity.​

Another possible culprit is your anti-virus application. Some versions identify a virus within the database and puts your database into quarantine. You will need to read the directions on how to release.

To find your old database, search for "Microsoft User Data" (without the quotes). You can also search on "Office 2011 Identities" or "Main Identity".

The best place to get help with Microsoft Office is on Answers.

Answers -Office for Mac

Getting Started: http://answers.microsoft.com/en-us/mac/forum/macstart
Word: http://answers.microsoft.com/en-us/mac/forum/macword
Excel: http://answers.microsoft.com/en-us/mac/forum/macexcel
PPT: http://answers.microsoft.com/en-us/mac/forum/macpowerpoint
Outlook: http://answers.microsoft.com/en-us/mac/forum/macoutlook
Entourage: http://answers.microsoft.com/en-us/mac/forum/macother 
 
  Sep 25, 2011 
veehb 
macrumors newbie 
Oct 5, 2009
Taylorsville, Utah
#4 
Thanks Dianeoforegon!

The information you posted lead me to the location of the Outlook 2011 identity file. I was able to go into Time Machine and replace the data folder with one a few days before I had the problem. It worked! 

I did have to let the system rebuild the database, which was automatic and when it had rebuilt the database, my Outlook was back on line. 

I think I caused the problem. I had imported a .pst file from my windows 7 based computer running Outlook 2007. It worked fine. I moved some folders from the "Outlook PST" folder organization to the mail folders I'd set up under Outlook 2011 on the MacBookPro. I've read that you can't do that and that moving things around can cause system problems.

Thanks again for your valuable information.

Vee 
 
  Sep 26, 2011 
dianeoforegon 
macrumors 6502 
[image: dianeoforegon]
Apr 26, 2011
Oregon
#5 
It's customary that Outlook will rebuild an Identity that was recovered from Time Machine.

Regarding .pst file import.

If you import any PST files, create a new Identity to import the file. Some users have lost all data after importing a PST file. Once you verify the imported file is OK, under File > Export select to export as .olm file. Import this file into your Main Identity. 

You will need to move the imported data into the correct local folders. 


Just something to try - make sure that you are in Outlook (use Alt-Tab until Outlook appears in the menu bar.) Then select Window->Zoom (or just Ctl-Cmd-Z.) That has fixed that problem for me in the past - worth giving it a try.

everything in my outlook for mac 2011. disappeared outlook itself is still there, but everything is gone. mail, calendar, contact and when i do a search, it basically says no file associated with this program 
More about : outlooks folders disappeared rebooted 
silverliquicity 
January 13, 2012 4:47:33 PM 
[bookmark: 9865315]Hey, im not to familiar with outlook but before you do anything about it, id do a full virus scan, dealing with what ever caused you to lose all your personal infomation is more important. 

Id recomend you also buy an external HDD to back things up to incase somthing like this happens again. 
Score
0
ulysses35 
January 13, 2012 5:18:56 PM 
[bookmark: 9865318]search for the PST file - this contains all the information relating to your contacts and mail.

If this file is missing then there is little chance of ever getting your data back.

However the good news is that if this file is found there ar several ways to recover all the missing info (and even deleted mail too) but using a hex editor to corrupt the first few blocks.... this forces outlook to rebuild the PST file.

if you google "repair PST" file there should be plenty of info on what Hex editor to use and also which blocks need corrupting
- See more at: http://www.tomshardware.com/forum/1246-69-outlooks-folders-disappeared-rebooted#sthash.ZkggHeAA.dpuf
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This post is part of a series called Mac for Beginners.
Firefox for Beginners
So you've decided to take the plunge and bought a Mac? Well first of all, congratulations! You'll soon find that owning a Mac really is an enjoyable experience and that the Mac really does adapt itself to you and your working habits. In this tutorial, we're going to look at OS X from an absolute beginner's point of view and cover the important bits that you need to know in a concise format, so you don't have to sift through endless books and web tutorials.

A (Very) Short Introduction to OS X
OS X is the default operating system on all Mac computers, and thanks to Apple's strict licensing agreements, it can only (legally, anyway) be run on Apple computers. Roughly every year an update is released for OS X, and all the releases are currently named after big cats (Tiger, Leopard, Snow Leopard, Lion, Mountain Lion, etc.). The most recent one was Mountain Lion - OS X 10.8
Unlike Windows, where each release tends to be a completely new and redesigned operating system, OS X goes for a more subtle approach - there are plenty of new features but the underlying core of the operating system often remains more or less unchanged.
In Switzerland, for example, Macs enjoy a usage share of 18.5%.
OS X is a UNIX-based operating system and is the second most popular operating system worldwide after Windows, with a global usage share of around 8% in July 2012. There are, however, countries where OS X enjoys a much larger share of the market - in Switzerland, for example, Macs enjoy a usage share of 18.5% and in Luxembourg around 16%.
Enough about OS X as an entity (there's always Wikipedia, right?). Let's start dive into the good stuff: how it actually works.
Tip: In this tutorial I am going to look at the traditional OS X features, not ones that came about in Mountain Lion (such as Notification Center). These are covered in greater detail in separate tutorials on this site!
Step 1: The OS X Interface
Although the interface in OS X is really easy to get to grips with, it can be a bit of a mystery if you are using a Mac for the first time. There are a few major areas to get to grips with.
Think of the Dock as a mixture of the task bar and Start menu on Windows.
The Dock
Think of the Dock as a mixture of the task bar and Start menu on Windows. It is a launcher for your most commonly used applications as well as an easy way to access your documents, downloads and so on.
[image: Dock]
My dock under OS X Mountain Lion
The little glowing rectangular icons underneath an icon show that the app is currently running either in the foreground or background. One odd little feature about OS X is that if you click on the red "close" icon in application windows, it does not automatically close down the application - it still runs in the foreground (more on this later).
To pin an application's icon to the Dock, open it up then right-click on it in the Dock. From here, select Options then Keep in Dock. This will ensure that even if you close down the application in question, its icon will still remain in the Dock for easy access.
To the right of the icons you've got a little dividing line (which, if you click on it, can be used to adjust the size of the Dock) and then three folders, namely Applications, Documents and Downloads, with the last icon for your Trash. Starting from OS X Leopard, your applications, personal documents and downloads can be displayed either as a folder or stack, and viewed either as a fan, grid or list.
[image: Stacks]
A stack (the Documents folder) in Grid view
You can, of course, remove these folders and add your own - to do so simply drag your folder of choice down to the area. To remove it, either drag it out of the Dock or right-click on it, go to Options then Remove from Dock.
By default, all of your open windows that you have minimized will show up next to the Trash icon. However, you can change this by going to the Apple menu in the top-left hand corner, scrolling down to Dock, then clicking on Dock Preferences and selecting Minimize windows into application icon. The Preferences area is also a great place to customize your Dock. For instance, you can change its size and magnification when you hover over it.
The Menu Bar
The menu bar runs along the top of your screen and contains the Apple menu (system-wide) whereby you can access features such as Software Update (more on this in a bit), the App Store and the System Preferences, as well as the menus for the particular app you are using. You can also restart and shutdown your Mac from the Apple menu as well.
[image: Status Bar]
The menu on OS X 10.8 Mountain Lion, with Safari running in the foreground
Alongside the menus, the menu bar also holds status icons for compatible applications (mine from left to right, for reference, are Skype, LittleSnapper, Dropbox, Evernote and Alfred) along with your OS X icons (from left to right: Time Machine, displays, Bluetooth, Wi-Fi status, volume, battery level, clock, current user, Spotlight and Notification Center). You can move these around by holding down the Command key and dragging them around. You can also get rid of one by dragging it out of the menu bar.
Finder
Think of Finder as the Windows Explorer of OS X (the name is a bit of a giveaway, I admit). It is responsible for managing all your files, disks, network drives and volumes and can also launch other applications (except the Dock). It's a pretty simple piece of UI to use once you get to know it and (in my opinion, anyway) is far simpler to use than Explorer.
[image: Finder OS X]
Finder in OS X, with my home folder on show
To access the Finder quickly, simply click on its icon on the far left of the Dock (the icon always remains visible). When you launch it, you've got your Favorites down the left-hand side (which often includes folders that you access regularly), any shared devices or drives on your local network (if you've own any Windows PCs, these often pop up here, ironically with a "Blue Screen of Death" icon!) and any external drives connected to your Mac.
[image: Finder Icons]
The toolbar in Finder (icons explained below)
Running along the top of your Finder, you've got a load of different icons. From left to right, here's what they do:
· Go back to last screen
· Go forward to next screen
· Show items in folder as a grid of icons
· Show items in folder as a list
· Split folders into individual columns
· Show items in a Cover Flow style (similar to iTunes
· Change the icon arrangement (e.g. by name, date modified, size, etc)
· Share the selected file (OS X Mountain Lion only)
· Quick Look (more on this below)
· Open Dropbox folder (if installed
· Perform tasks (this is the same as the right-click menu, i.e. if you right-click on an item
There is no address bar in Finder where you can quickly type in locations (unlike in Explorer). However, you can jump to a particular folder by clicking on Go then Go to Folder or by pressing Shift + Command + G. You can also perform some basic commands from Finder, such as compressing folders (File then Compress "folder") and burning folders to discs (File then Burn "folder" to Disc).
Quick Look
Quick Look is a really useful little feature that allows you to preview the contents of a file without having to open it first, which comes in really handy for reading the contents of PDFs or Word documents, for example, without having to load up Microsoft Word or Preview first.
[image: Quick Look]
Quick Look enabled for an Adobe PDF file.
There are three ways to bring up Quick Look:
1. Select the file or folder then hit Space
2. Click on the eye icon in the Finder toolbar
3. If your Mac has a trackpad, tap the file/folder with three fingers on the trackpad (thanks to Jacob for this!) 
There are, however, a couple of limitations to Quick Look. First, you can't view files inside folders (not on Lion or Mountain Lion anyway). Further, there are a number of file formats that don't work with it, however, these are mostly specialist file extensions and will hopefully not cause too much trouble for the beginner Mac user.
You can also give Quick Look a boost with some handy plugins - see Robert's awesome article for more complete instructions.
Mission Control
If there's one feature about OS X that I absolutely adore (and miss so much when I'm using Windows), it's Mission Control. It gives you an overview of every single application running on your Mac just by pressing a single button (this is usually F3 on newer Macs, or F9 on older ones) or, if you've got a Magic Mouse, by double-tapping with two fingers (this can be changed in System Preferences).
[image: App Store]
Mission Control
Mission Control also gives you an easy way to access your Dashboard (if you prefer to use this) and you can add additional desktops if your current one is getting too cluttered (previously this was done via Spaces in the menu bar). Simply hover over the top-right hand corner of Mission Control, where a translucent picture of your current desktop background along with a little + symbol should pop up then click on it, which should add a new blank desktop.
[image: Multiple Desktops]
Five active desktops open in Mission Control
Bear in mind though that having lots of extra desktops open at once may impact on system performance, especially if you're using a slightly older Mac. Check out our article on Mastering Mission Control for more on this awesome utility.
Step 2: Working with Applications
So, now that you've gotten to grips with OS X as a whole, let's start looking at those little things that'll make your Mac experience even bettr: apps!
Where to Find Apps
There are two main places to find OS X applications: on the web and through the Mac App Store. Given the rise in popularity of Macs over recent years, there has been a bigger trend towards developing Mac applications and you'll find that most major programs come in both Windows and Mac versions.
There are even a ton of apps that are specifically designed for the Mac and therefore often offer a far richer user experience. Why? They are designed with OS X in mind and really utilize its features rather than simply being a port of the Windows version.
[image: App Store]
The home page of the Mac App Store, available on all Macs running OS X 10.6.6 and above
The best place to start looking for apps is the Mac App Store, as you'll find a good range of applications there to get you started, sorted according to category and rating. You'll need an Apple ID and will have to to register your payment information with the App Store (even if you only plan to download free apps) before you can start downloading.
Not all apps available for the Mac can be bought from the App Store due to Apple's strict guidelines. However, you can find a pretty wide selection on there (there's around 11,000 to choose from). Otherwise, apps can be purchased from individual developer websites without any problems.
Installing Applications
One interesting peculiarity about OS X is the way you install apps. If you've used a UNIX/Linux system before then the process will be pretty straight forward. Most apps come in the form of a DMG (disk image) file, which has to be mounted onto a virtual drive before it can be installed. You can mount as many images as you want without any problems, however bear in mind that the images have to be unmounted before deletion.
[image: DMG icon]
The standard icon for a disk image (DMG) file in OS X
To mount a disk image, simply double-click on it in Finder. It should pop up on the desktop as a white mounted drive and also in the Favorites bar of the Finder we saw earlier. To unmount it, simply drag its icon to the Trash (which should turn temporarily into an Eject symbol) or click on the little Eject symbol next to it in the Favourites bar of the Finder.
[image: https://cdn.tutsplus.com/mac/authors/legacy/James%20Cull/2012/08/14/Thunderbird%20Disk%20Image.png]
Installing an application is as simple as dragging its icon into the Applications folder - OS X will do the rest for you
As Macs are all about simplicity, most disk images make installing the program a piece of cake. Simply grab the application icon and drag it into your Applications folder, where it will copy across all files needed. To delete an application, simply drag it into the Trash can (if this method doesn't work, then go into the Applications folder in Finder and delete the file by pressing Command + Delete - you will usually be prompted to enter a password).
[image: https://cdn.tutsplus.com/mac/authors/legacy/James%20Cull/2012/08/14/Application%20Stack.png]
An application "stack", which usually directs to /Macintosh HD/Applications
Some programs (e.g. larger programs such as Adobe Photoshop and Microsoft Office) often have their own installation programs, similar to Windows (and these programs have to be respectively deinstalled using a special program - do not simply drag them into the Trash as it will leave remnants of the application lying around on your hard disk drive.
Step 3: Going Deeper
Now we've looked at some of the basic functions of OS X, let's conclude this tutorial by spending a bit of time getting to know OS X on a deeper level.
System Preferences
The System Preferences pane, accessible from the Apple menu in the top-left hand corner of your desktop, is the control center for your Mac. This is where you can tweak virtually every aspect of your computer. It is fairly self-explanatory and is sorted into a variety of sections to help you find your way around better.
[image: https://cdn.tutsplus.com/mac/authors/legacy/James%20Cull/2012/08/15/System%20Preferences.png]
The Systems Preference pane on OS X
Remember, if you're not sure of a particular section, be sure to click on the ? icon in the bottom-right hand corner to be directed to the Help Center. We will also be featuring a series on System Preferences entitled Getting Intimate With Your System Preferences over the next few weeks, so for a more in-depth look at each item head over there!
Software Update
Apple periodically release updates to both their own software and hardware to ensure complete compatibility with your Mac and, more importantly, to patch up any security holes and bugs discovered. Since Mountain Lion, the Software Update function has been bundled in with the App Store (instead of being a standalone application). However, its functionality is still pretty much the same.
[image: https://cdn.tutsplus.com/mac/authors/legacy/James%20Cull/2012/08/15/Software%20Update.png]
You can change the options for Software Update by heading over to its panel in System Preferences
Most Mac apps also have their own built-in update system and some (such as Google Chrome) will automatically download and install updates in the background, so you're always running on the most current version. Be sure to check the Automatically check for updates option, which will look for updates in the background as you use your Mac. If any are due to be installed, a window will pop-up prompting you to install the necessary updates (or a notification will appear in the Notification Center on Mountain Lion).
Advertisement
Keyboard Shortcuts
Keyboard shortcuts are always take some getting used to when you start using a new operating system, so I've listed a couple of useful ones here for reference!
In The Finder
As a general rule, common Windows shortcuts such as copy (CTRL + C), paste (CTRL + V) and so on can be replicated on the Mac by replacing the Control with the Command key. So copy is Cmd + C, cut is Cmd + X, select all is Cmd + A and so on. But there are a couple that are unique to OS X:
· Enter renames the selected file (as supposed to launching it)
· Space enables Quick Look (mentioned above)
· Shift + Cmd + N creates a new folder in the active directory
· Cmd + Delete sends the selected file(s) to the Trash
· Shift + Cmd + Delete empties the Trash with confirmation
· Shift + Option + Cmd + Delete empties the Trash without confirmation
Global Shortcuts
· Option + Cmd + Esc brings up the Force Close dialogue (similar to Ctrl + Alt + Delete on Windows) where you can shut down unresponsible applications
· Cmd + Tab quickly switches between applications, just like in Windows
· Cmd + H hides the current app you're in (similarly, Cmd + M minimises the app you are in)
· Fn + Up / Fn + Down works the same as the Page Up and Page Down on Windows
· Likewise, Fn + Left takes you to the top of a document/page (like the Home button) and Fn + Right takes you to the end of a document/page (like the End button)
· Cmd + Space is the default command to bring up Spotlight, an easy way to find files and folders on your Mac
· Cmd + Shift + 3 takes a full-screen shot of your screen and saves it onto your Desktop in PNG format
· Similarly, Cmd + Shift + 4 lets you take a screenshot of a specific area by dragging. To take a shot of a specific window, hit Space afterwards then select the window/item you want to take a shot of
· Cmd + Eject brings up the Restart/Sleep/Cancel/Shut Down dialog
· Hit Option plus a sound key (Volume Up/Down or Mute) to quickly open the Sound panel in System Preferences and Option plus a Brightness key to quickly open up the Displays panel.
Of course, each application has its own keyboard shortcuts as well and I could spend all day going through them all. However, a really quick and easy way to access a list of all keyboard shortcuts for any particular program is to download CheatSheet, which is free and brings up a window of all common keyboard shortcuts for the particular program you are using simply by holding down the Command key.
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(@ Software Update keeps OS X and apps from the Mac App Store up to date.

™ Automatically check for updates
¥ Download newly available updates in the background
You will be notified when the updates are ready to be installed.
@ Install system data files and security updates

() Automatically download apps purchased on other Macs
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